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Thank you very much for purchasing this product.

» To ensure correct and safe usage with a full understanding of this product's performance, please be sure to read through
this manual completely and store it in a safe location.

» Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.

» The contents of this operation manual and the specifications of this product are subject to change without notice.

» The operation manual and the product have been prepared and tested as much as possible. If you find any misprint
or error, please inform us.

» Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur through use of
this product, regardless of any failure to perform on the part of this product.

» Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur with respect to
any article made using this product.
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1-1 What This Document Assumes and Related Manuals

What This Document Assumes

Before performing any operations described in this guide, make sure that all the following preparations are
complete.
» Assembling and installing VersaUV series printers
» Installing VersaWorks on your computer, and connecting the computer to the VersaUV series via a net-
work

Related Manuals

Read the following documentation for information about setting up the VersaUV series printer and Versa-
Works.

(@ Setup Guide ( First Step Guide for LEF-12, LEF-20 )
This manual covers details about how to use the VersaUV series, including how to set up the printer and where
to locate the printer, etc. Be sure to read this manual. (Up to "First Time Printing" is explained for LEF-12, LEF-20.)

® User's Manual ( MASTER GUIDE for LEF-12, LEF-20 )
This manual describes operation methods in detail. After you've read the VersaUV series Setup Guide, be sure
to read this manual.

® VersaWorks Quick Start Guide

This manual explains basic operations of VersaWorks, including how to set up the program. Be sure to read
Chapter 1 of this manual and make necessary setups on your computer. After you've read the VersaUV series
User’s Manual, be sure to read this manual. It is also recommended to read Chapter 2 of this manual and be-
come familiar with how to use this program.

4 Chapter 1 Getting Started



1-1 What This Document Assumes and Related Manuals

VersaWorks Online

This document describes basic procedures to perform printing using white ink and gloss ink.

Of course, methods of printing using white or gloss ink other than the ones in this document are also avail-
able. You can use lllustrator's transparency features, or perform other special printing operations not covered
in this document. You can get information on these advanced printing methods and the latest information
about VersaWorks by viewing VersaWorks Online.

If you want to learn more about the features of VersaWorks, or if you want to use white or gloss ink more ef-
fectively, be sure to visit VersaWorks Online.

VersaWorks Online: http://dg4.roland.co.jp/en/RVW2forWeb/index.html

VersaWorks Online can be displayed by clicking [Help] and [VersaWorks Online] from the Main menu.

File(F) Edit(E) View(V) Job(J) Printer(P) Media(M)

Show Help

VersaWorks Online(0)...

About Roland VersaWorks(A]...

Chapter 1 Getting Started



1-2 White Ink Features and Printing Methods

Features of White Ink

The exclusive white ink that this printer uses achieves high density and concealment, and is capable of
providing attractive results when white and CMYK colors are overprinted. This ink is suited to printing on
transparent media, and can be used it to create items for shop interiors and displays, PET bottles and other
packages, decals, and more.

Methods of Printing Using White Ink

Printing using white and CMYK ink

When you're printing using white and CMYK color inks, this printer runs the areas that use the white ink and
the CMYK color inks simultaneously, in a single pass, so stable, highly intricate printing having no misalign-
ment due to feed is possible. When you're printing using transparent media, you can create results intended
to be viewed from the back (the side opposite the printed surface) by reversing the image and changing the
sequence in which white and CMYK colors are printed.

= P. 22, "Printing White and CMYK Color Inks in a Single-Pass"

Printing White Only or CMYK Colors Only

You can also perform printing using only white ink or only CMYK color inks.
To display the side opposite the printed surface, you can take such action as printing a mirror image of the
artwork.

= P. 26, "Printing Using Only White Ink"

= P. 28, "Printing Using Only CMYK Inks"
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1-3 Gloss Ink Features and Printing Methods

Features of Gloss Ink

The exclusive Gloss ink that this printer uses is colorless and transparent, and can impart a glossy feel to the
printed item, as well as enhancing weatherability and robustness.* Also, depending on the printing settings,
you can even deliberately eliminate glossiness and produce a matte finish, or perform fill overprinting using
gloss ink to raise the printed surface and create an embossed finish.

* Glossiness, weatherability, and robustness may vary depending on the media used, the environment, and
other printing conditions.

Methods of Printing Using Gloss Ink

Gloss-finish Printing

This printing method imparts a glossy finish to the printed item. Forming a coating of gloss ink imparts a glossy
finish and can also achieve high weatherability and robustness.
When you're overprinting an item already printed using white or CMYK color inks, you pull back the printed
item and perform fill overprinting with gloss ink.

= P. 30, "Gloss-finish Printing (White or CMYK Colors = Gloss)"
Printing using only gloss ink is also possible.

= P. 41, "Printing Using Only Gloss Ink"

Matte-finish Printing

This printing method eliminates glossiness and produces a restful matte finish. This perform fill overprinting
of white and CMYK colors with gloss ink, which makes it possible to produce results where glossiness is sup-
pressed while weatherability and robustness are enhanced.
When you're using white ink to overprint an item already printed using white or CMYK color inks, you pull
back the printed item and perform fill overprinting with gloss ink.

= P. 32, "Matte-finish Printing (White or CMYK Colors => Gloss)"
When you're not using white ink, CMYK color inks and gloss ink are applied in one pass; there is no need to
pull back the printed item.

= P. 34, "Matte-finish Printing (Single-pass CMYK and Gloss Printing)"
Printing using only gloss ink is also possible.

= P. 41, "Printing Using Only Gloss Ink"

Embossed-finish Printing

This printing method can produce items that have a three-dimensional feel by performing fill overprinting
of the item using gloss ink. You determine the height to which the printed surface is raised by setting the
number of fill-overprint passes in VersaWorks. After performing fill-overprinting by this specified number of
passes, the item is overprinted one last time using gloss ink to produce a gloss finish.
When you're overprinting an item already printed using white or CMYK color inks, you pull back the printed
item and perform fill overprinting with gloss ink.

= P. 35, "Embossed-finish Printing (White or CMYK Colors = Gloss)"
Printing using only gloss ink is also possible.

= P. 41, "Printing Using Only Gloss Ink"
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2-1 Printer Preparations

Making the Printer Settings and Loading Media

When Using Transparent Media (LEC-300A / 330 / 540, LEJ-640)

When you're using transparent media, make the necessary printing settings on the printer and load the media
accordingly.

Procedure

o Press menu on the printer and make the following settings.
For LEC-330A/ 330/ 540
Set [EDGE DETECTION] to "DISABLE."
For LEJ-640
Set [SHEET TYPE] to "CLEAR."

9 Load transparent media into the printer.
» When the media you are loading into the printer warps or partially floats from the platen, load it into
the printer so that its front end goes about 20 cm (8 in.) from the starting edge of the print area.
» Be sure to use the media clamps when you load media.

When Using Media Other Than Transparent Media (LEC-300A / 330 / 540, LEJ-640)

Load the media using the method described in the User's Manual

* In the case of LEF-12 and LEF-20, make the printer setting and load the media in accordance
with the supplied documentation.

10 Chapter 2 Getting Ready



2-2 Preparing VersaWorks

Starting VersaWorks

Start VersaWorks on the computer you're using.

Procedure

o From the [Start] menu, click [All programs (or Programs)] - [Roland VersaWorks] - [Ro-
land VersaWorks].
Main window appears.

(2] Check to make sure that "Model (or Nick-
= R_ﬂ"l“ﬂ SRR name) of Your Printer” is displayed on the
o o e Memi T | upper left of the main screen, and that

Rl Status” is set to "Ready to Print.

Status ‘Ready te Prnt

Creating a Folder for Saving PS Files

Before you actually print an image you draw using application software such as Adobe lllustrator, it is necessary
to save the image as a PS file (s). And then, you can print the image by loading the PS file (s) on VersaWorks.
Because of this, you should create a folder for saving PS files in advance. It is recommended to locate the folder
in the root directory on your computer's local disk.

Procedure

o Open [Computer] (or [My Computer]), and then open [Local Disk (C:)].

9 Create a new folder.
e, Compricr s WM 7> cLo ) seawn  Click [File], [Create New], and then [Folder], or click
Organize + [ Open  Includeinlibrary =  Sharewith =  Bum  Newfolder "New Folder" from the menu.

9 Favorites
B Desktop
18 Downloads
%] Recent Places

Name the created new folder.
Here you name the folder "White-gloss_print", for

Organize v [ Open  Includeinlibary v Sharewith »  Bum | €Xample.
¢ Favorites L

M Desktop ' E | White-gloss print

8 Downloads T e

% Recent Places 1. Program Files

Chapter 2 Getting Ready 11



2-3 Preparing Printing Data

Basic Approach for Creating Printing Data

When you want to print using white ink

Apply the spot color named "RDG_WHITE" to the areas you want to print using white ink.

When you want to print using gloss ink

Apply the spot color named "RDG_GLOSS" to the areas you want to print using gloss ink.

Creating Data for Printing

Create the data for printing using white ink and gloss ink.

The program used to create the printing data is Adobe Illustrator CSé. For detailed information on drawing
methods and how to work with palettes, refer to the documentation or online help for Adobe Illustrator
CSé. If you're using another version of Adobe lllustrator, operations may be somewhat different from those
explained here.

1. Open the exclusive swatch library

0 At the swatch palette menu, select [Open Swatch Library], then [Other Library].
The "Select a Library to open" window appears.
*The swatch palette is displayed by going to the menu and selecting [Window], then [Swatch].

12

Swatches

Mew Swatch...

New Color Group...

Color Properties
Corporate

Default Swatches

Duplicate Swatch Earthtone
Merge Swatches Foods
Delete Swatch Gradients
Ungroup Coelor Group Kids Stuff
Select All Unused el
Add Used Colors s
Neutral
Sort by Name Poad
Sobviling Scientific
Show Find Field T

Srnall Thumbnail View

Medium Thumbnail View

Systern (Macintosh)
Systern (Windows)

Large Thumbnail View Textiles
Srnall List View VisiBoned
Large List View Web

User Defined

Swatch Options...
Spot Colors...

Roland Texture System Library

(

Open Swatch Library

Other Library...

Save Swatch Library as ASE...
Save Swatch Library as Al..
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2-3 Preparing Printing Data

9 @ Open folder in the order of [Computer] (or [My Computer]) — [Local Disk (C:)] —
[Program Files] — [Roland VersaWorks] — [Swatch] — [lllustrator], then select "Roland
VersaWorks.ai."

Depending on the settings of your computer, the extension ."ai" might not be shown.
® Click [Open].
The swatch library containing "RDG_WHITE" and "RDG_GLOSS" is displayed.

B Ope |
R S |« Swatch » Dllustrator > Search llustrator 2
Organize v New folder =~ 0 @
@ Documents “*  Name i Date modifi
M
J p S Bl Roland Color System Library 12/11/2006
ct
E vld i ‘B Roland Grapac Bri-o-coat Library 11/24/2009
i Bl Roland Metallic Color System Library 12/1/2009 2
= ¢ = ‘a Roland Metallic Color 10/22/2009
omputer 3
. & o — @a Roland Metallic Texture System Library 6/23/2010 3
— e
o 5 B Roland Texture System Library 2/17/20109:
) -print e T
b [l Roland VersaWorks §/21/2009 1
ki Peliag
1 Program Files
1. Program Files i
1 Users =l r
File name: Roland VersaWorks @ watch Files (7). -]
( Open Can:el‘

By saving the "ai" file selected in steps 9 into the folder below, you can register each swatch library
to the Adobe lllustrator's library. Once the registration is performed, you can open the library directly
from the swatch palette menu, eliminating the need to search the file every time you start Adobe
Illustrator.

C:\Program Files\Adobe\Adobe Illustrator CS6\Presets\(language abbreviation)\Swatches

*"'C" is the name of your computer's local disk.

*The language abbreviation differs depending on the language used.

*Depending on the lllustrator used, "\Preset\Swatch" may be used instead of "\Presets\(language
abbreviation)\Swatch" is "\Preset\Swatch."

2. Create the illustration, and specify the spot color that matches the color you want to print.

o Create the illustration.
Note: Be sure to draw the illustration in the CMYK mode.

Continued on the next page
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2-3 Preparing Printing Data

9 Specify each spot color that matches the color you want to print.

Desired ink or color

Spot color name

White ink

RDG_WHITE

Gloss ink

RDG_GLOSS

Untitled-1 (CMYK/Preview) x

Specify "RDG_GLOSS" for the areas
where you want to use gloss ink.

NOWBOARD SHiop

Specify "RDG_WHITE" for the areas
where you want to use white ink

14 Chapter 2 Getting Ready




2-3 Preparing Printing Data

3. Create the PS (PostScript) file.

o _ @ Select [Print] from the [File] menu.

ot . e @ Select [RolandVW].
e, !
Qe Recenk Fles »
Browse in Bridge... Bk Coi-0 .
. - ®) Click [Setup].
o e
S ) COpH.. AteCirk5 - -
Swe s Tenpts. @ Click [Continue].
Sarve for Wl B+ Shift+Cirke5
Tt Fekeched Fhost.,
Reweit F2
Placs.
Sarve Tor MECTOSO GMice. .
Ept..
Horipls. »
Document setug.. Lol
@ Dacument Colos Made "
Filenfo.. Ak=Shifte Cirl+]

Continued on the next page
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2-3 Preparing Printing Data

General |
Select Pinter
i Rolandvw
% RolandVW_(XR-540)

: D@,
=~ e
Locatian:

Comment Find Prirter...

P_m-ﬁmw

TrueType Fe [2) ansi C
=-fim Document Opti [3) ansiD
Advanced P 5] ansi E

-~ Pages per Sl [2) ARCH A

@) PostScript C (5] aRCH B

& # Printer Featy [5) ARCH

i+ InputAdt (59 ARCHD

Outputd 29 ARCH E

LL] Numberof copies: 1 3]
Selection Curent Page
Pages
- x
Layour | Paper/Cuualty
Orientation:
.
Page Order:
Front to Back -
Page Format
Pages per Shest 1 0w
[] Draw Barders
| Advaneed... |
_I)
8 Roland VersaWorks Advanced Document Settings
=-42] Peper/Qutput
er
=[] Graphic 0
@) Image Colo( 5 41
IEMMel ) a2
ICM Inte [ 43
- Scaling! 100 29 g

Chapter 2 Getting Ready

@ Turn on the [Print to file] option.
®) Click [Preferences].
®) Click [Advanced] in the [Layout] tab.

@ Click the down arrow to the right of the
[Paper Size] box, and then click [PostScript
Custom Page Size] from the list that ap-
pears.

® For "Custom Page Size Dimensions,"
enter the values in the "Width" and "Height"
fields.

Enter values for the same size as the illustration you
created in step 2.



2-3 Preparing Printing Data

@ Click [OK] three times to close the "PostScript Custom Page Size Definition," "Roland
VersaWorks Advanced Options," and "Printing Preferences" dialog boxes.

o

The "Print" dialog box returns.

=l
Seoct P
B olnav

8 RolandVW_(XR-640)

Sas: Ready

- 0fFE
Date modified Type Size
This folder is empty.

Select the folder you created in P. 11,
"Creating a Folder for Saving PS Files".

Assign the name you want. It may be a
good idea to assign a name that indicates
that the file uses white and gloss ink.

@ Click [Print].

® Click [Print].

@ Specify the destination and file name.
Example: " C:¥white-gloss_print " for the folder to
save to, and " label_white-glossprint.ps " as the file
name

®) Click [Save].
The CMYK layer of the image is saved as a PS file.

@ Open the folder you saved to and make sure the file has been created.

Chapter 2 Getting Ready
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3-1 Introduction

Before You Start Printing

» Remove just the white ink cartridge, shake the cartridge 50 times (about 15 seconds), then
reinsert it.

» Shaking each time is unnecessary for the ink cartridges other than the white one. However,
when installing new ink cartridges, be sure to shake them.

1\ The precipitation of the ingredients in the ink disables
I[’//&D/AA, printing in normal color. To allow the ingredients to be
e mixed well, shake each ink cartridge horizontally from
t _ side to side by 5 cm (2 inches) from each end of the

ink cartridge.

The ingredients in white ink tend to settle. Each day, before starting the day's operations,be sure to carry out
the above steps. Allowing the ink to stand without carrying out these steps can cause the settled material to
harden, resulting in malfunction or other problems.

Print Modes

When you're printing on media in this machine, you need to set print mode based on the type of ink, printing
method (single-pass, white only, CMYK only, glossy finish, matte finish, embossed finish), and the side from
which printed image is seen (image seen from printed surface, image seen from opposite side of printed
surface). This section gives a brief overview of each type of print mode.

Print mode Overview Page
This print mode is for single-pass printing. Printing of white
White -> CMYK, or data and CMYK color data is performed in a single pass, but P23
White -> CMYK (v) the sequence is such that the white ink is overprinted by the '
CMYK color inks.
This print mode is for single-pass printing. Printing of white
CMYK -> White, or data and CMYK color data is performed in a single pass, but P 24
CMYK ->White (v) the sequence is such that the CMYK color inks are overprinted ’
by the white ink.
White, or White (v) This mode is for printing white color data only. P.26
CMYK, or CMYK (v) This mode is for printing CMYK color data only. P.28
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3-1 Introduction

GlossVarnish (v)

This print mode is for glossy finish on the printed item. After
performing printing using white and CMYK color data, it
pulls back the media, then performs fill overprinting using
gloss ink.

This mode can also be printed using only gloss ink.(¥)

P.30
(*)P.41

MatteVarnish (v)

This print mode is for matte finish on the printed item. After
performing printing using white and CMYK color data, it pulls
back the media, then performs overprinting using gloss ink.
This mode can also be printed using only gloss ink.(¥)

P.32
(*)P.41

CMYK -> MatteVarnish, or
CMYK -> MatteVarnish (v)

This print mode is for matte finish on the printed item. Print-
ing of gloss ink and CMYK color data is performed in a single
pass, but the sequence is such that the CMYK color inks are
overprinted by the gloss ink.

P.34

Embossing (v)

This print mode is for embossed finish by raising the printed
surface through fill overprinting using gloss ink. After per-
forming printing using white and CMYK color data, it pulls
back the media, then performs overprinting using gloss ink
This mode can also be printed using only gloss ink.(¥)

P.35
(*)P.41

Chapter 3 Printing
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3-2 Printing Using White or CMYK Color Inks

22

Printing White and CMYK Color Inks in a Single-Pass

This section describes how to perform printing using both white ink and CMYK color inks. This method prints
CMYK color data and white data in a single pass, but you vary the printing settings depending on how the
finished results are you be viewed (the printed surface or the side opposite the printed surface) and on which
type of ink is the undercoat.

Procedure

0 Make sure that you have finished making the preparations for VersaWorks, creating the
printing data, and getting the printer ready (= P. 9, "Chapter 2 Getting Ready").

(2]

B Roland VersaWorks
FilelF) Edit{E) View(¥) Job{)) PrinteriP) Media(M) H

(A

Layout

Color
Adustment

File: Format

T3

=
I
*

ol

r
=3

o
&
=
o

»

LE

g
&

Management

Clp and Tie

Media Sattings
Size + [CustomROLL |

Get Media Width
Wi 136100 = mm H: 000 3: mm

Scaling

Scale 7IE.ED 3: %
we | = o H =L

[~ Fit to Media Siz=

Pogition

¥ 00 = mm e [000 =] mm
[~ Genter on the Media

Frint Froperties

Copy. 1 Hi

I™ Pae Ranee
from = =
Tile Spacing: [A00 =] mm

[ Mirror

Orientation :

Ey @
D
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Double-click "y .
"Queue A Properties" window appears.

@ At the "Queue A Properties” window,
make the basic settings for printing.
Clicking an icon on the left side of the window
switches what is displayed on the right side. Refer
to the table following and make the settings for the
respective items.

@ After making the settings, click [OK]
Close the "Queue A Properties" window.



3-2 Printing Using White or CMYK Color Inks

When You Want to Display the Printed Surface of the Finished Results (White Ink Undercoat)

Transparent
media, etc.

You will have the printed image
from this side (the printed surface
of the finished results).

Note: The white and the CMYK color inks are printed in a single-pass, but are shown here as separate
layers in order to indicate the printing sequence.

Icon Setting Item Setting

Al
Mirror Off

Layout

Generic, Generic High-opacity White

Media Type (*1), or Generic Distance (*3)
] White -> CMYK; or
Quali '
U= Mode White -> CMYK (v) (*4)
@ Operation Mode Print Only
Cutt
Eentials Return to Origin After Off
( Not used for Print

LEF-12 and LEF-20 )

(*1) About "Generic High-opacity White"

» It makes possible output of white of higher opacity than "Generic."

» This option can be selected only in the case that the ink type is ECO-UV CMYKWW or ECO-UV3 CMYKWW
, which uses two white ink cartridges in addition to cyan, magenta, yellow, and black ECO-UV or ECO-UV3
ink cartridges.

» It cannot be used when you use ECO-UVS ink.

(*2) In case using LEF-12 when you print on a media of which has uneven print surface, set the Print Quality
to "Distance.”

(*3) In case using LEF-20 when you print on a media of which has uneven print surface, set the Media Type
to "Generic Distance."

(*4) When you want to make CMYK color inks the undercoat, even in cases you want to display the printed
surface of the finished results to be the surface displayed, select the "CMYK -> White" or "CMYK -> White
(v)" setting.
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3-2 Printing Using White or CMYK Color Inks

When You Want to Display the Side Opposite the Printed Surface of the Finished Results (CMYK Undercoat)

Transparent
media, etc.

You will have the printed
image from this side
(the opposite side of the
printed surface of the
finished results).

Note: The white ink and the CMYK color inks are printed in a single-pass, but are shown here as separate
layers in order to indicate the printing sequence.

Icon Setting Item Setting

[
EJ Mirror On

Layout

) Generic, Generic High-opacity White
*2) Media Type (*1), or Generic Distance (*3)

CMYK -> White, or

It
Aty Mode CMYK -> White (v) (*4)
@ Operation Mode Print Only
Cut
Controls

Return to Origin After
( Not used for Print ¢ Off

LEF-12 and LEF-20 )

(*1) About "Generic High-opacity White"

» It makes possible output of white of higher opacity than "Generic.

» This option can be selected only in the case that the ink type is ECO-UV CMYKWW or ECO-UV3 CMYKWW,
which uses two white ink cartridges in addition to cyan, magenta, yellow, and black ECO-UV or ECO-UV3
ink cartridges.

» It cannot be used when you use ECO-UVS ink.

(*2) In case using LEF-12 when you print on a media of which has uneven print surface, set the Print Quality
to "Distance

(*3) In case using LEF-20 when you print on a media of which has uneven print surface, set the Media Type
to "Generic Distance."

(*4) When you want to make the white ink undercoat, even in cases the side opposite the printed surface of
the finished results is to be the surface displayed, select the "White -> CMYK" or "White -> CMYK (v)" setting.
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3-2 Printing Using White or CMYK Color Inks

® Go to "Job List" and click the "Queue
Status | Job Name | Input Time "
= Job List 00 #om A" tab.
[T e Pt o 12 @ Drag the print job you created in P. 12,
"Creating Data for Printing" to the queue A job list.
The contents of the file are displayed in the preview
window, and the layout on the media is displayed
in the layout window. Areas using "RDG_WHITE"
are displayed with shading in transparent magenta.
If the areas using "RDG_WHITE" are not displayed
with shading, the settings of "Mode" is incorrect. Go
back to the procedure eand select the correct
mode.

® click [ .

Printing will be started.
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3-2 Printing Using White or CMYK Color Inks

Printing Using Only White Ink

Procedure

o Make sure that you've finished making the preparations for VersaWorks and getting
the printer ready (= P. 9, "Chapter 2 Getting Ready").

9 Prepare the printing data.
Using a program such as Adobe lllustrator, create the data for printing white only. When creating the
data, remember to specify "RDG_WHITE" as the color.
= P. 12, "Creating Data for Printing"

9 Make the settings in the "Queue A Properties” window.
Double-click @, and in the "Queue A Properties" window that appears, make the basic settings for
printing as shown following.

Icon Setting Item Setting
AL
Mirror (*1)
Lapaut

Generic, Generic High-opacity White (*2),

—_ Media Type or Generic Distance (¥4)
Qualty (*3) Mode White, or White (v)
m Operation Mode Print Only
6Ty
Contrals
( Not used for Return to Origin After Print Off

LEF-12 and LEF-20 )

1

When showing the finished printing from the printed surface: Uncheck the box.

When showing the finished printing from the opposite side of the printed surface: Check the box.

(*2) "Generic High-opacity White"

» It makes possible output of white of higher opacity than "Generic".

» This option can be selected only in the case that the ink type is ECO-UV CMYKWW or ECO-UV3 CMYKWW,
which uses two white ink cartridges in addition to cyan, magenta, yellow, and black ECO-UV or ECO-UV3
ink cartridges.

» It cannot be used when you use ECO-UVS ink.

(*3) In case using LEF-12 when you print on a media of which has uneven print surface, set the Print Quality
to "Distance.

(*4) In case using LEF-20 when you print on a media of which has uneven print surface, set the Media Type
to "Generic Distance.

After making the settings, click [OK] to close the "Queue A Properties™ window.
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3-2 Printing Using White or CMYK Color Inks

@ Go to "Job List" and click the "Queue

Status | Job Name | Input Time

= Job List 00 #om A" tab.
P O
[ W-G_DataProc_temp_00... 1@) @ Drag the print job you created in P. 12,

"Creating Data for Printing" to the queue A job list.
The contents of the file are displayed in the preview
window, and the layout on the media is displayed
in the layout window. Areas using "RDG_WHITE"
are displayed with shading in transparent magenta.
If the areas using "RDG_WHITE" are not displayed
with shading, the settings of "Mode" is incorrect. Go
back to the procedure gand select the correct
mode.

® click [,

Printing will be started.
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3-2 Printing Using White or CMYK Color Inks

28

Printing Using Only CMYK Inks

Procedure

o Make sure that you've finished making the preparations for VersaWorks and getting
the printer ready (= P. 9, "Chapter 2 Getting Ready").

@ Prepare the printing data.
Using a program such as Adobe lllustrator, create the data for printing CMYK colors only.

@ Make the settings in the "Queue A Properties” window.

Double-click @ and in the "Queue A Properties" window that appears, make the basic settings for
printing as shown following.

Icon Setting Item Setting
(AL
Mirror *1)
Lapaut

Generic, Generic High-opacity White (¥2),

Media Type or Generic Distance (*4)
it
Bely Mode CMYK, or CMYK (v)
r&.}‘ Operation Mode Print Only
)
Contrals
( Not used for Return to Origin After Print off

LEF-12 and LEF-20)

(*1)

When showing the finished printing from the printed surface: Uncheck the box.

When showing the finished printing from the opposite side of the printed surface: Check the box.

(*2) About "Generic High-opacity White"

»The output results are the same whether "Generic" or "Generic High-opacity White" is selected.

» This option can be selected only in the case that the ink type is ECO-UV CMYKWW or ECO-UV3 CMYKWW,
which uses two white ink cartridges in addition to cyan, magenta, yellow, and black ECO-UV or ECO-UV3
ink cartridges.

» It cannot be used when you use ECO-UVS ink.

(*3) In case using LEF-12 when you print on a media of which has uneven print surface, set the Print Quality
to "Distance.

(*4) In case using LEF-20 when you print on a media of which has uneven print surface, set the Media Type
to "Generic Distance.

After making the settings, click [OK] to close the "Queue A Properties™ window.
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3-2 Printing Using White or CMYK Color Inks

@ Go to "Job List" and click the "Queue
A" tab.

Status | Job Name | Input Time

Job List f. mom
fere i
[ : - 1@) @ Drag the print job you created in P. 12,
"Creating Data for Printing" to the queue A job list.
The contents of the file are displayed in the preview
window, and the layout on the media is displayed in
the layout window.

® click [ .

Printing will be started.
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3-3 Printing Using Gloss Ink

Gloss-finish Printing (White or CMYK Colors = Gloss)

This section describes the printing method that produces a glossy finish on the printed item. After performing
printing using white and CMYK color data, it pulls back the media, then performs fill overprinting using gloss ink.
This means that the setting must be made to pull back the media after printing the white and CMYK color data.
* In the case of LEF-12 and LEF-20, there is no need to make the setting for "Return to Origin
After Print".

Procedure

o Make the setting to pull back the media after printing, then perform printing of the white
and CMYK color data.
*In the case of LEF-12 and LEF-20, there is no need to make the setting for "Return to
Origin After Print".
Carry out printing according to the procedure for printing white or CMYK color data described in P. 22,
"3-2 Printing Using White or CMYK Color Inks". At this time, in addition to the settings described, also make
the setting to pull back the media after printing.

Icon Setting item Setting
)
T Return to Origin After Print On
Controls

Only in the case of LEF-12 and LEF-20
The following message is displayed in the menu window when printing is finished. Press on
the operation panel of the printer without replacing the media and go on to step .

FINISHED PRINT
o
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3-3 Printing Using Gloss Ink

@ @ Double-click the print job.
@ At the "Job Settings" window, make the basic settings for printing.
Clicking an icon on the left side of the window switches what is displayed on the right side. Refer to the
table following and make the settings for the respective items.

== =5
File(F) EGtE) View(V) Job{)) Printer(P) Media(M) Help(H}
| = b Lk LEC330
2 | = = = = = = =]
St | ink i
w | s g
| ! E
) /
==X sl
— [ =_w-G_Datal temp_DO01.al ol
Qas | Job Name Mick Nem ,‘ \ — = EI

Pessms e Fl= N EEE0@E
Medis Setlings = L L L s L.t Pl el
See: [GmeOll 3]
GetMedatidh |

w: [fEE e 000 e 3
Scaing :
Sode: [0 = x

w066 =Jam H:[@8 =] mm E

I™ Fi 10 Media Size

Fosiion
X 0w v 00 Fmm E

I Centes o the Meda

= =
TieSpesng: [200 = mn i

I Minar

Ountatcn [E £ |

Clp and Tie.

E ®
i) : el =
Icon Setting item Setting
Media Type Special Effects
Quality Mod GlossVarnish (v)
@3‘ Operation Mode Print Only
Eut'
Contrals
( Not used for Return to Origin After Print Off
LEF-12 and LEF-20)

@ After making the settings, click [OK]

Close the "Job Settings" window.

The contents of the file are displayed in the preview window, and the layout on the media is displayed in
the layout window. Areas using "RDG_WHITE" are displayed with shading in transparent magenta, and
areas using "RDG_GLOSS" are displayed with shading in transparent cyan. If the areas using "RDG_WHITE"
and "RDG_GLOSS" are not displayed with shading, the settings of "Mode" is incorrect. Go back to the
procedure 9-@ and select the correct mode.

© ciick[™.

This prints only the gloss-ink areas of the print job.
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3-3 Printing Using Gloss Ink

Matte-finish Printing (White or CMYK Colors = Gloss)

This section describes the printing method that produces a matte finish on the printed item. After performing
printing using white and CMYK color data, it pulls back the media, then performs overprinting using gloss ink.
This means that the setting must be made to pull back the media after printing the white and CMYK color data.
* In the case of LEF-12 and LEF-20, there is no need to make the setting for "Return to Origin
After Print".

Procedure

o Make the setting to pull back the media after printing, then perform printing of the white
and CMYK color data.
*In the case of LEF-12 and LEF-20, there is no need to make the setting for "Return to
Origin After Print".
Carry out printing according to the procedure for printing white or CMYK color data described in P. 22,
"3-2 Printing Using White or CMYK Color Inks". At this time, in addition to the settings described, also make
the setting to pull back the media after printing.

Icon Setting item Setting
B,
T Return to Origin After Print On
Contrals

Only in the case of LEF-12 and LEF-20
The following message is displayed in the menu window when printing is finished. Press on
the operation panel of the printer without replacing the media and go on to step .

FINISHED PRINT
o
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3-3 Printing Using Gloss Ink

@ @ Double-click the print job
@ At the "Job Settings" window, make the basic settings for printing.
Clicking an icon on the left side of the window switches what is displayed on the right side. Refer to the
table following and make the settings for the respective items.

File(F) Edit(E) View(v) Job()) Printen(P) Media(M) Help(H)

g =i G
- o
(= WX a mm@

\settings

— =

@] Y - Mecia Satings =r IV I I
Siee: [CustomAOLL -

Gel Media Widlh

W [7660 Zjmm H:[000 erlm ]

Seaing

Scde: 000 = x

w: 3086 =jmm H:[€48 =] mm 3

I Fi o Media Size

- Job Lt LEC330
% = =

===
F= o) @FE0 @@

I L

W-G_DataProc_temp_001.al.ps]

Satus | Job Name

RIP Status ‘

Posiion
K 000 Hmm v 000 = om E

I Cerlex o the Meda

i Fropeties
Copy =
I Pege Ren

= =3
Ti Spacing: 400 =] mm 5

™ Miar

Oiertatcn E B —

Cipand Tie

Icon Setting item Setting
Media Type Special Effects

Cuality Mode MatteVarnish (v)
ﬂ&__)‘ Operation Mode Print Only
Cut
Controls
( Not used for Return to Origin After Print Off

LEF-12 and LEF-20 )

® After making the settings, click [OK]

Close the "Job Settings" window.

The contents of the file are displayed in the preview window, and the layout on the media is displayed in
the layout window. Areas using "RDG_WHITE" are displayed with shading in transparent magenta, and
areas using "RDG_GLOSS" are displayed with shading in transparent cyan. If the areas using "RDG_WHITE"
and "RDG_GLOSS" are not displayed with shading, the settings of "Mode" is incorrect. Go back to the
procedure 9—@ and select the correct mode.

© ciick ™.

This prints only the gloss-ink areas of the print job.
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3-3 Printing Using Gloss Ink

Matte-finish Printing (Single-pass CMYK and Gloss Printing)

This section describes how to perform single-pass printing using gloss and CMYK color inks. This printing
method produces only a matte finish.

Procedure

o Make sure that you’ve finished making the preparations for VersaWorks and getting
the printer ready (= P. 9, "Chapter 2 Getting Ready").

@ Prepare the printing data.
Using a program such as Adobe lllustrator, create a file that uses gloss and CMYK color inks. When creating

the data, remember to specify "RDG_GLOSS" as the color.

= P. 12, "Creating Data for Printing"

@ Make the settings in the "Queue A Properties” window.

Double-click @ the "Queue A Properties" window that appears, make the basic settings for printing as

shown following.

Icon Setting item Setting
Generic with Special Effects, or
Media Type Generic Distance with Special
Effects (*1)
Quality .
Mode CMYK -> MatteVarnish, or
CMYK -> MatteVarnish (v)
r&} Operation Mode Print Only
-Cu.t'
Caontrals
Return to Origin After Print Off

( Not used for
LEF-12 and LEF-20)

(*1) In case using LEF-20 when you print on a media of which has uneven print surface, set the Media
Type to "Generic Distance with Special Effects."

After making the settings, click [OK] to close the "Queue A Properties™ window.
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3-3 Printing Using Gloss Ink

@ Go to "Job List" and click the "Queue
A" tab.

Status | Job Name | Input Time
J@M;ob List

[(C_TWWGD BT 12 @ Drag the print job you created in P. 12,
"Creating Data for Printing" to the queue A job list.
The contents of the file are displayed in the preview
window, and the layout on the media is displayed
in the layout window. Areas using "RDG_GLOSS" are
displayed with shading in transparent cyan. If the
areas using "RDG_GLOSS" are not displayed with
shading, the settings of "Mode" is incorrect. Go back
to the procedure @ and select the correct mode.

® click [ .

Printing will be started.

Embossed-finish Printing
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3-3

Printing Using Gloss Ink

(White or CMYK Colors = Gloss)

36

This section describes the printing method that produces an After performing printing using white and CMYK
color data, it pulls back the media, then performs fill overprinting using gloss ink. This means that the setting
must be made to pull back the media after printing the white and CMYK color data.

* In the case of LEF-12 and LEF-20, there is no need to make the setting for "Return to Origin

After Print".

You use VersaWorks to set the number of fill-overprinting passes using gloss ink. The unit performs matte-
finish fill overprinting for the specified number of passes, then performs overprinting one additional time to
give the surface a glossy finish. This means that the number of fill-overprint passes using gloss ink is equal to
the number set using VersaWorks plus one.

Procedure

o Make the setting to pull back the media after printing, then perform printing of the white
and CMYK color data.
*In the case of LEF-12 and LEF-20, there is no need to make the setting for "Return to
Origin After Print".
Carry out printing according to the procedure for printing white or CMYK color data described in P. 22,
"3-2 Printing Using White or CMYK Color Inks". At this time, in addition to the settings described, also make
the setting to pull back the media after printing.

Icon Setting item Setting
B,
T Return to Origin After Print On
Contrals

Only in the case of LEF-12 and LEF-20
The following message is displayed in the menu window when printing is finished. Press on
the operation panel of the printer without replacing the media and go on to step .

FINISHED PRINT
o

@ O Double-click the print job
@ At the "Job Settings" window, make the basic settings for printing.
Clicking an icon on the left side of the window switches what is displayed on the right side. Refer to the
table following and make the settings for the respective items.
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3-3 Printing Using Gloss Ink

File(F) ESIHE) View(v) Job()) Printer(P) Media(M) Help(H)

- Job Lt LEC230

FoTo e |
i xR @FED@E

GetMada Wih

w: (28 Hum H:F0 Jwom E

]& T S —— =[5 - -
Bl 4 see: [omerl =
X

Sealng
Scale: [10000 =]

w08 Hmm W66 e E
I™ Filo Media Sie I

Pasiion

% [0 m v: 000 Fm E

I™ Centes am the Meda

| = =
| Thespasng: [L00 =] e
ok

I M

Opertaien E B ‘

Icon Setting item Setting
Media Type Special Effects
Huiality Mode Embossing (v)
Use Custom Settings On
<For LEC-330/ 540, LEJ-640>
EP”Tel[ Overprint* I to 7times
ontiels P <For LEC-300A, LEF-12, LEF-20>
1to 10 times
r&.)‘ Operation Mode Print Only
Cut'
Controls
( Not used for Return to Origin After Print Off
LEF-12 and LEF-20 )

Note: The specified number of overprinting passes and ink thickness
Refer to the graph below.
» The number of overprint passes for an embossed finish is the specified number of passes plus one.
» The ink thickness based on the specified number of overprint passes varies according to the type of media
used and the printing environment.
» If the print heads scrape the printed surface or if the media becomes jammed, check the number of overprint
passes, the media type, and the position of the print heads. However, if the position of the print heads is
too high, the resulting print may be rough.
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3-3 Printing Using Gloss Ink

For LEC-330 / 540, LEJ-640 (Cyan, Magenta, Yellow, Black, Gloss, White (CMYKGIW))

For reference: specified number of overprinting passes and ink thickness

High Quality

Standard

= )

(Set using

SSOUNDIU} U|

(L+ sessed jo Jaquinu
pai0ads Jo ssauxdIy})

o
o

1 3 5 7 (Number)

Specified number of overprinting passes » Media: uncoated PET film
» Ambient temperature: 25 °C (77 °F)

For LEC-330 / 540, LEJ-640 (Cyan, Magenta, Yellow, Black, Gloss, Gloss (CMYKGIGI))

For reference: specified number of overprinting passes and ink thickness

(mm)

0.8 High Quality

Standard

(Set using ouaiy .)

SSOUNDIY} YU

(1+ sessed jo Jaquinu
pouoads Jo ssauxdIy})

o
o

1 3 5 7 (Number)

Specified number of overprinting passes » Media: uncoated PET film
» Ambient temperature: 25 °C (77 °F)
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3-3 Printing Using Gloss Ink

For LEC-300A

For reference: specified number of overprinting passes and ink thickness

0.4 (M™

High Quality

Standard

SSOUXDI} U]

(Set using auaiy .)

(1+ sessed Jo Jaquinu
pauIoads Jo ssauxdIy})

0.0 1' I é I 5 7 10  (Number)

Specified number of overprinting passes » Media: uncoated PET film
» Ambient temperature: 25 °C (77 °F)

For LEF-12, LEF-20

For reference: specified number of overprinting passes and ink thickness

0.4,™

SSOUNDIU} |

(1+ sessed Jo Jaquinu
pal0ads Jo SSaUXdIY})

0.0 e

» Media: uncoated PET film

Specified number of overprinting passes
pecil u verprinting p » Ambient temperature: 25 °C (77 °F)
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3-3 Printing Using Gloss Ink

40

® After making the settings, click [OK]

Close the "Job Settings" window.

The contents of the file are displayed in the preview window, and the layout on the media is displayed
in the layout window. Areas using "RDG_WHITE" are displayed with shading in transparent magenta, and
areas using "RDG_GLOSS" are displayed with shading in transparent cyan. If the areas using "RDG_WHITE"
and "RDG_GLOSS" are not displayed with shading, the settings of "Mode" is incorrect. Go back to the
procedure 9—@ and select the correct mode.

Click [PH.,

This prints only the gloss-ink areas of the print job.
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3-3 Printing Using Gloss Ink

Printing Using Only Gloss Ink

Gloss finish, matte finish, and embossed finish can also all be printed using only gloss ink.

Procedure

o Make sure that you’ve finished making the preparations for VersaWorks and getting
the printer ready (= P. 9, "Chapter 2 Getting Ready").

@ Prepare the printing data.
Using a program such as Adobe lllustrator, create the data for printing gloss only. When creating the data,
remember to specify "RDG_GLOSS" as the color.
= P. 12, "Creating Data for Printing"

@ Make the settings in the "Queue A Properties” window.
Double-click e84, the "Queue A Properties” window that appears, make the basic settings for printing as
shown following.

Icon Setting item Setting
Media Type Special Effects
2|
S <For gloss finish> GlossVarnish (v)
Quality Mode <For matte finish> MatteVarnish (v)
<For embossed finish> Embossing (v)
= Use Custom Settings On
Frinter
Contios <For LEC-330/ 540, LEJ-640>
. 1 to 7 times
Embossed Overprint <For LEC-300A, LEF-12, LEF-20>
finish only X
1 to 10 times
@-}I Operation Mode* Print Only
.l:ut'
Cantrals
( Not used for Return to Origin After Print Off
LEF-12 and LEF-20)

Note: The specified number of overprinting passes and ink thickness
A graph showing reference values is given on P. 38 to 39. Refer to it for details.
» The number of overprint passes for an embossed finish is the specified number of passes plus one.
» The ink thickness based on the specified number of overprint passes varies according to the type of media
used and the printing environment.
» If the print heads scrape the printed surface or if media jams occur, re-evaluate the number of overprinting
passes, the media type, and the position of the print heads. Note, however, that raising the print heads
may cause print quality to be coarse.

After making the settings, click [OK] to close the "Queue A Properties™ window.
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3-3 Printing Using Gloss Ink

42

o

Status | Job Name

| Input Time

- @ Job List i
eV
&=L

W-G DataProc temp 00...

12

Chapter 3 Printing

@ Go to "Job List" and click the "Queue
A" tab.

@ Drag the print job you created in P. 12,
"Creating Data for Printing" to the queue A job list.
The contents of the file are displayed in the preview
window, and the layout on the media is displayed
in the layout window. Areas using "RDG_GLOSS" are
displayed with shading in transparent cyan. If the
areas using "RDG_GLOSS" are not displayed with
shading, the settings of "Mode" is incorrect. Go back
to the procedure 6 and select the correct mode.

® click M .

Printing will be started.
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4-1 More Advanced Printing Settings

Making Printing Settings for Each Job

Procedure

Before executing printing, double-click the print job
Display the "Job Setting" window. This window is where you make advanced settings for a specific job,
including settings that control printer operation and color adjustment.

ToT& s
File(F) Edit(E) View(v) Job()) Printer(P) Media(M) Help(H)
- Job List LEC-330
8“ | 0 = = = = = = = |
:I_
i g
e —
B Job Settings [ #%_W-G_Databroc_temp_001.al.ps] [E=3 o8 =]
Stalus | Job Name Mk Nam
Pt e (- = = |WoRe)EEFH0 B
@ Media Sellings = [ i o i -] L. Fd W
FiP Status i Size: |CusternROLL v
- el Madia Wadlh 1
Double-click a printing job ] BT CH T R
calng .
Sode: 1000 4 %
wi [3086 Jmm H:[6948 Jem =
I~ Fitto Media Size -
Pashon 1
% [0 o v 000 m E
I™ Genler o the Wedia -
Pt Froperbes:
Coy i =) e
I Page
FHE« FHE
Tis Spacing [400 = mm i
™ Minor
Orientation
(R () ) (= H
Eip;’ln‘lia Eﬁ
Vanable i
Dala

Description

In outputting many jobs consecutively, if different printing settings are required for each job, making such
settings is generally a time-consuming task. To solve this problem, you can make the settings for the respective
jobs at the "Job Settings" window before starting the printing operation. In other words, with this approach,
you make shared basic settings at the "Queue Properties" window, and make the settings for the individual
job at the "Job Setting" window. The settings in the "Job Setting" window are updates with the settings made
at the "Queue Properties" window, so you can make job-specific settings such as color adjustment.

44 Chapter 4 Advanced



4-2 More Advanced Printing Data Creation

White or CMYK Colors = Gloss: When You Want Keep Changes in Settings to a Minimum

The program used to create the printing data is Adobe Illustrator CS6. For detailed information on drawing
methods and how to work with palettes, refer to the documentation or online help for Adobe Illustrator CS6.
If you're using a different version of Adobe lllustrator, some of the operations may differ from the explana-
tions given below.

1. Ccreate separate layers for the CMYK-color or white printing data and the gloss printing data.

o Prepare the spot colors (special colors) "RDG_WHITE" and "RDG_GLOSS."
= P. 12, "Creating Data for Printing" step 1.

@ Create the illustration for the areas using CMYK color and white data.
When drawing the illustration, give attention to the following points.
» Draw in CMYK mode.
» If you used two or more layers when drawing, then before you proceed to the subsequent operations,
move all drawings to the same layer (named "Layer 1" here).

@ At the layer palette menu, select "Options

:*W;L for 'Layer 1™

ew Sublayer..

®uphm "Layer 1" "Layer Options " window appears.
Jelete Selection

Note: The layer palette is displayed by going to the
menu and selecting [Window], then [Layer].

[ (Opticnsfor "Layer 1.

Make/Release Clipping Mask

) ]

Enter Isolation Mode

Exit Isolation Mode @ Name the |aye|".
Assign "CMYK-white" (for example) as the name.

® Click [OK].

Color: Light Blue - l:‘

Template Lock

v Print

Dim Ima

Cancel

Continued on the next page
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4-2 More Advanced Printing Data Creation

o

7_@ @ At the layer palette menu, select "New
e < po || Layer"
Duplcate "MV E-white "Layer Options " window appears.
st s Note: The layer palette is displayed by going to the
menu and selecting [Window], then [Layer].

Options for "CMYK-white"...

Make/Release Clipping Mask
Enter Isolation Mode

Exit Isolation Mode

@ Assign a name to the layer for the gloss.

l - Assign "Gloss" (for example) as the name.
® Click [OK].

E|:|||:||': Magenta v l:l

Lock

v Print

@ Dim Images to:
Cancel

Click the "Gloss" layer
Create the illustration for the areas using gloss.
Specify "RDG_WHITE" as the color of the areas using white.

Specify "RDG_GLOSS" as the color of the areas using gloss.

N 99009

Save the CMYK-color or white printing data and the gloss printing data separately.

At the layer palette, display "CMYK-white"
only.

=]

@ Create the PS (PostScript) file.
The PS file only for "CMYK-white" is created.
Assign a name of "label_cmyk-white.ps" to the file here, for example.
= P. 15, "Create the PS (PostScript) file."
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@ Create the PS (PostScript) file.
The PS file only for "Gloss" is created.
Assign a name of "label_gloss.ps" to the file here, for example.

= P. 15, "Create the PS (PostScript) file."

4-2 More Advanced Printing Data Creation

At the layer palette, display "Gloss" only.

3. Atthe "Queue A Properties" and "Queue B Properties" windows, make the basic settings for printing.

o

Reland VersaWorks

Frle{Fi EditiE) View(¥] Job{l]] PrnterlP] MedialMi H

Double-click ).
"Queue A Properties" window appears.

9 At the "Queue A Properties” window, make the basic settings for printing the CMYK

color data or white data.

Make settings for each item referring to the table below.

Icon Setting item Setting
: Generic, Generic High-opacity White, or
Media Type Generic Distance

=4 Refer to P. 22, "3-2 Printing Using

Cuiality Mode White or CMYK Color Inks" and select
the mode that matches the target
results.

jon Mode Print Onl
fk‘l Operation y
Cut
Eonieh Return to Origin After Print On

( Not used for
LEF-12 and LEF-20)
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4-2 More Advanced Printing Data Creation

©

Raland VersaWarks

FiledF) Edit{E) View(V) Job{)) PrinteriP) MedialM) H

N
Statue Ready to Pt

R

Double-click &) .
"Queue B Properties" window appears.

@ At the "Queue B Properties” window, make the basic settings for printing white data

only.

Make settings for each item referring to the table below.

Icon Setting item Setting
Media Type Special Effects
. Refer to P. 30, "3-3 Printing Using
Baclky Mode Gloss Ink" and select the mode that
matches the target results.
s Use Custom Settings On
E:F'nntelr
e <For LEC-330/ 540, LEJ-640>

Embossed Overprint* 1to 7 times
finish only P <For LEC-300A, LEF-12, LEF-20>

1 to 10 times

()
Cut
Controls
( Not used for

LEF-12 and LEF-20)

Operation Mode

Print Only

Return to Origin After Print

Off

Note: The specified number of overprinting passes and ink thickness
A graph showing reference values is given on P. 38 to 39. Refer to it for details.
» The number of overprint passes for an embossed finish is the specified number of passes plus one.

» The ink thickness based on the specified number of overprint passes varies according to the type of media
used and the printing environment.

» If the print heads scrape the printed surface or if the media becomes jammed, check the number of overprint
passes, the media type, and the position of the print heads. However, if the position of the print heads is
too high, the resulting print may be rough.
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4-2 More Advanced Printing Data Creation

N

Execute printing of the CMYK color data or white data.

Go to "Job List" and click the "Queue A" tab.

Drag "label_cmyk-white.ps" to the queue A job list.

Click @] .

Printing of the CMYK color data or white data is executed. After output, the media is taken back up and
printing of the gloss data is executed.

@00

Only in the case of LEF-12 and LEF-20
The following message is displayed in the menu window when printing is finished. Press onthe
operation panel of the printer without replacing the media and go on to step 3..

FINISHED PRINT
J

g

Execute printing of the Gloss data.

Go to "Job List" and click the "Queue B" tab.

Drag "label_gloss.ps" to the queue B job list.

Click @] .

Printing of the gloss data is executed.

@00

Description

When you perform fill overprinting using gloss ink after printing using white or CMYK color inks, you can
keep the changes to settings during printing to a minimum by modifying the settings for the method you
use to create the printing data and the settings for the queue folder. With this method, you first break down
and save separate printing data for white and CMYK colors on the one hand and for gloss on the other, and
also selectively use queue folders A and B: one for white and CMYK color data, and one for gloss data. This
method requires more preparations before you perform printing, but is effective when you don't want to have
to modify the printing settings for each individual job.
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4-3 Creating Decals (Cutting after Printing)

*This explanation applies only to LEC-330A / 330 / 540.

Overview of Decal Creation

You can carry out cutting after completing printing by drawing what are known as "cutting paths" in the im-
age data used for printing. This feature is useful, for example, when you want to make stickers using adhesive
transparent film media. For information about how to draw cutting paths, see "Roland VersaWorks Quick Start
Guide"

When you're cutting a printed surface, we recommend carrying out a cutting test before the actual operation.
For information on how to perform a cutting test, refer to User's Manual of your printer.

Creating Decals Through Printing Using CMYK Color Inks or White Ink

Change the following points on the respective procedures described in "3-2 Printing Using White or CMYK
Color Inks."

» Add cutting paths to the printing data.
» At the "Queue A Properties" window, make the settings shown below for "Cutting Control," then carry out

printing.
Icon Setting item Setting
()
T Operation Mode Print & Cut
Controls

The above process enables cutting to start automatically when printing is finished.

Creating Decals Through Printing Using Gloss Ink

Change the following points on the respective procedures described in "3-3 Printing Using Gloss Ink."

» Add cutting paths to the printing data.

» When you're performing printing using gloss ink, at the "Queue A Properties" window (or "Job Setting"
window), make the settings shown below, then carry out printing.

Icon Setting item Setting
()
T Operation Mode Print & Cut
Controls

The above process enables cutting to start automatically when printing is finished.
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4-4 Composing Printing Data

Composing Printing Data Containing Only CMYK Colors or Containing Only White (or Gloss)

VersaWorks has a feature for composing printing data containing only CMYK colors or only white (or gloss).
To use this feature, the following requirements must be met.
» The printing-data combination that you can compose is a single set of printing data contain-
ing only CMYK colors or only white (or gloss).
» The printing data is a TIFF file. Also, for printing data containing white (or gloss) only, when
saving the TIFF file, for "TIFF Options,” set "Color Mode" to "Grayscale."

In the explanations in this section, Adobe Illustrator CS6 is the program used to create the printing data.

Procedure

o Make sure that you’ve finished making the preparations for VersaWorks and getting
the printer ready (= P. 9, "Chapter 2 Getting Ready").

@ Create printing data containing only CMYK colors and only white (or gloss).
= P. 45, "White or CMYK Colors = Gloss: When You Want Keep Changes in Settings to a Minimum" step 1.

Continued on the next page

Chapter 4 Advanced 51



4-4 Composing Printing Data

52

©

Ctrl+N

New...
MNew from Template... Shift+Ctrl+N
Open... Ctrl+0
Open Recent Files 3
Browse in Bridge... Alt+Ctrl+0
Close Ctrl+W
Save Ctrl+5
Save As... Shift+Ctrl+S
Save a Copy... Alt+Ctrl+5
Save as Template...
Save for Web... Alt+Shift+Ctrl+5
Save Selected Slices...
Revert F12
Place...
@ Saue far Microsoft Office...
(E)(portg
Scripts 3
Document Setup... Alt+Ctrl+P
Document Color Mode 3
File Info... Alt+Shift+ Ctrl+|
Print... Ctrl+P
Exit Ctrl+Q
v oesrE

femtype  Dotemodfied

Fiefolder 20131134

Fiefolder /5720131005

Cancel
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@ At the layer palette, display "CMYK" only.

® From the menu, select "File," then "Ex-
port."

® Specify the destination and file name.
@ For "Format," specify "TIFF (*.TIF)."
® Click [Save].

® Under TIFF Options, set "Color Model"
to "CMYK."



4-4 Composing Printing Data

@ At the layer palette, display "White (or
Gloss)" only.

® From the menu, select "File," then "Ex-
port."

@ Specify the destination and file name.
@ For "Format," specify "TIFF (*.TIF)."

® Click [Save].

® Under TIFF Options, set "Color Model"

New... Ctrl+N

Save as Template...
Save for Web...

Save Selected Slices...

New from Template... Shift+Ctrl+MN to "Glayscale'"
Open... Ctrl+O

Open Recent Files 3

Browse in Bridge... Alt+Ctrl+ O

Close Ctrl+W

Save Ctrl+5

Save As... Shift+Ctrl+5

Save a Copy... Alt+Ctrl+5

Alt+Shift+Ctrl+5

FEe
4 Rz 1

Revert F12
Place...
@ Save for Microsoft Office...
(Exportg

Scripts 3
Document Setup... Alt+Ctrl+P
Document Color Mode »
File Info... Alt+Shift+Ctrl+|
Print... Ctrl+P
Exit Ctri+Q

2

B

tem type

Filefoder
Filefoder

Date modiied

57203 1134
3372013 104,

&

Sove

pling)
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4-4 Composing Printing Data

54

(54

B Roland VersaWorks
File{F) EditiE) View(V] Job{)) Printer(P] Medis(M) H

@ fm‘m\\_\

Double-click )
"Queue A Properties" window appears.

@ At the "Queue A Properties” window, make the basic settings for printing.

= P.19, "Chapter 3 Printing"

Add the following settings.

Icon Setting item Setting
<When composing printing data containing
white only>
:%! EX1=RDG_WHITE
Composition
e Beiiek <When composing printing data containing
gloss only>
Ex1=RDG_GLOSS
im Number of Jobs 2
i
Job
4 anagement Compose On
® Go to "Job List" and click the "Queue
Status | Job Name | Input Time "
— @ Tr—— A" tab.

B G_Datatf
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@ Drag the print job you created in step ©
and @ to the queue A job list.
Composing is performed automatically.

® click [4 .

Printing will be started.



4-4 Composing Printing Data

Description

Your printer can be used for proofing of such as soft packaging and package. In such the case, the commercially
available software RIP may be used for color matching with the color of printing machine. The matched colors
may be stored in a TIFF file depending on some type of commercially available software RIP. In addition, CMYK
and white (or gloss) values are stored separately.

By using the composing feature of VersaWorks, the TIFF files of CMYK and white (or gloss) can be composed to
a single print job. This result allows single-pass printing of the CMYK ink and white (or gloss) ink, which offers
some effects such as shorter printing time.*

* Single-pass printing of the gloss ink and CMYK ink is enabled only for the matte-finish printing.
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4-5 Performing Texture Printing

What is Texture Printing?

Texture printing is a printing method to produce texture patterns with gloss ink. This uses the texture patterns
of the exclusive library to create and output the printing data.

(IMPORTANT!)

* For the finishing state, we recommend "matte-finish printing.” It is difficult to produce fine-textured
expressions with gloss-finish or embossed-finish.

* Create the printing data using the Adobe Illustrator version of CS or later if using Adobe Illustrator.
If you use the earlier version before Adobe Illustrator 10 to create the printing data, the texture pat-
terns may result in poor condition.

Printing a Texture Chart

The texture chart is the printing sample of the texture pattern. By printing the texture chart, you can confirm
the "complete texture chart" representing the texture itself that can be printed with "Your Printer" and "Your
Media" (slight pattern differences is possible to occur depending on the conditions of the printer and media.)
By selecting a pattern from this texture chart and creating the printing data using that selected pattern, you
can print your intended pattern almost perfectly.

With VersaWorks, you can print the texture chart of "Roland Texture System Library."

*To print a chart, use the same media as the one actually going to be used.

Procedure

o Make sure that you have finished making the preparations for VersaWorks, creating the
printing data, and getting the printer ready (= P. 9, "Chapter 2 Getting Ready").

9 = Double-click ().
and Yersa'Works . .
FiledF) Edit(E) View(¥) Jobl)) PrinterP) MedialM) ™ The [Queue A Propertl.eS] W.IndOW z'ippears.
*Texture chart outputis available with Queue A only.

_ =l
Dot Raadyto Pt

@fmﬁ
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Queue A Properties = e
g“' @am Seltings
=
i Type:
Layout R
Genetic with Special Efects -
=3 PintQualty: ¢ Attsic
Qusiity " High Qualty
‘ @ Standard
L © HighSpeed
gl
ids
Variable
Data |l

4-5 Performing Texture Printing

@ Click 23, configure the settings in [Qual-
ity Settings] and [Color Management].

* For details on settings, refer to the followings.

= P. 32, "Matte-finish Printing (White or CMYK Colors
= Gloss)"

= P. 34, "Matte-finish Printing (Single-pass CMYK and
Gloss Printing)"

= P. 41, "Printing Using Only Gloss Ink"

® Click [OK].

Note: When printing a texture chart, the [Quality] settings from the [Queue Properties] window are always
applied. Since you cannot change the quality settings for the job using the [Job Settings] window after it
has been added, be sure to configure the settings in the [Queue Properties] window before performing the
following operations.

o

File(

View(v) Job{)) _Printer() [Media(M)) Help(H)

[ b

Status Resdy o Prin

st
n =l

Y= w\

Media Explorer(W)
Print Roland Color System Library
Color Chart Type-1
Color Charz=zg-2
Color Se
Color Ch\ »

< Joxture System Library.

{ Chart

Status | Job Name [ Nick

The fallawing jab will be printed.
0 you weant to continue

o

File Mame : Chart

Tl

Page Size: 4199 2969mmx 1P

)

Status | Job Name

/ Queue A ' Queus B

- Job List

| Input Time

Chart

05/28 13:42

58, "Create The Texture Printing Data".

@ Click [Media] and then [Chart].

@ Check the page size.

If the size of the media loaded on the printer is not
adequate for the page size, change it to another
media of sufficient size.

® Click [OK].
The print job of the texture chart is added to the

job list.

Click [T,

The texture chart of "Roland Texture System Library'
is printed.

* Using the printed chart, specify your desired texture pattern in accordance with Procedure 2.inP
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4-5 Performing Texture Printing

58

Create The Texture Printing Data

To create the data for the texture printing, please follow the instructions below. The program used to create
the printing data is Adobe Illustrator CS6. For detailed information on drawing methods and how to work with
palettes, refer to the documentation or online help for Adobe lllustrator CS6. If you're using another version
of Adobe lllustrator, operations may be somewhat different from those explained here.

1. Open the exclusive library.

o At the swatch palette menu, select [Open Swatch Library], then [Other Library].
The "Select Library" window appears.
*The swatch palette is displayed by going to the menu and selecting [Window], then [Swatch].

Color Properties 4
New Swatch... Corporate
New Color Group... Default Swatches 3
Duplicate Swatch Earthtone
Merge Swatches Foods 3
Delete Swatch Gradients 3
Ungroup Color Group Kids Stuff
Select All Unused Reetal
Add Used Colors i :
Neutral
Sort by Name Patterns o
ot byking Scientific v
Show Find Field Tiimmes
Small Thumbnail View System (Macintosh)
Medium Thumbnail View System (Windows)
Large Thumbnail View Textiles
Srnall List View VisiBone2
Large List View Web
Swatch Options... = Y
Spot Colors... Roland Texture System Library
('| Open Swatch Library 4 | Other Library...
Save Swatch Library as ASE...
Save Swatch Library as Al...
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4-5 Performing Texture Printing

9 @ Open folder in the order of [Computer] (or [My Computer]) — [Local Disk (C:)] —

[Program Files] — [Roland VersaWorks] — [Swatch] — [lllustrator], and then select
"Roland Texture System Library.ai" and "Roland Grapac Bri-o-coat Library.ai."
Depending on the settings of your computer, the extension "ai" might not be shown.

® Click [Open].

The exclusive swatch libraries "Roland Texture System Library" and "Roland Grapac Brio-coat Library"

are displayed.

= 4+ L » llustrator v & Search Illustrator ¥l

QOrganize « New folder =~ M @

Roland Texture System Library

Y Favorites @wama ° Date modified Type
B Desktop Tl Roland Color Sustern | ihrans 12/11/2006 413 PM__ Adohe lllustrator ...
4 Downloads. ‘a Roland Grapac Bri-o-ceat Library 11/24/2009 11:44 ... Adobe lllustrjtor ...
%] Recent places “Bli Roland Metallic Color System Library 12/1/2009 1:09 PM Adobe lilustiftor ...
‘a Roland Metallic Color 10/22/2009 5:10 PM  Adobe lllustrjtor ...
i Libraries ‘a Roland Metallic Texture Systern Library 6/23/2010 2:14 PM Adabe lllustiftor ...
@ Documents ‘a Roland Texture System Library 2/17/2010 8:28 PM Adobe lllusti}ter ...
Jﬁ Music @l Roland VersaWorks §/21/2009 10:43 AM  Adobe lllustrator ...
[&5] Pictures
BE Videos

% Computer
i Local Disk () ¥ €

File name:

at Library

[ e Vi P P Pl

f Illustrator.

|

By saving the "ai" file selected in step 9 into the folder below, you can register each swatch
library to the Adobe lllustrator's library. Once the registration is performed, you can open the
library directly from the swatch palette menu, eliminating the need to search the file every

time you start Adobe lllustrator.

C:\Program Files\Adobe\Adobe Illustrator CS6\Presets\(language abbreviation)\Swatches

*"C" is the name of your computer's local disk.
*The language abbreviation differs depending on the language used.

*Depending on the lllustrator used, "\Preset\Swatch" may be used instead of "\Presets\(language

abbreviation)\Swatch" is "\Preset\Swatch."
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When this screen is displayed, click
"Update.”
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4-5 Performing Texture Printing

2. Create lllustrations and Specify Texture Patterns You Wish to Use

o Create the illustration.
Be sure to draw the illustration in the CMYK mode.

9 Assign the desired texture patterns to the areas for the texture printing.
Using the chart printed in P. 56, "Printing a Texture Chart", check the texture patterns and specify
a desired one. As there is a slight difference in color and pattern according to media, be sure to check
colors and patterns in the chart printed on the media same as the one that you are actually going to use.
The areas where the texture patterns are assigned shall be printed with gloss ink. For the areas other
than where the texture patterns are assigned, use the special spot color, "RDG_GLOSS," to apply gloss.
= P. 12, "Creating Data for Printing"

N — -l e

M| The area to be printed with the texture pattern =
| From " Roland Texture System Library," specify the
3l texture pattern such as "RTSLGeometrc- 100."

The area to be printed with the texture pattern =
From "Roland Grapac Brio-coat Library," specify the
texture pattern such as "RTSLGrapac- B01S."

Group Selection q >

*The name of the texture pattern is displayed on the data of lllustrator. The texture of the displayed im-
age appears rougher than that of the actual print.
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4-5 Performing Texture Printing

3. Create the PS (PostScript) file.

(1) ® Click [Print] from the [File] menu.

P ® Select [RolandVW]
Hew from Templsbe... Shift-Chi+ N
Tpen a0
e B ® Click [Setup].
Close: oW
S Ciri5 . .
e s @ Click [Continue].
S b Cop. ALk 5
Save 15 Templrte..
S Tor el At+5hift+Cirie 5
Sane Sebected Hices..
Rewert Fl.
Plsce.
S fov Microsoft Dice...
Bt
Saripls »

@)ﬂﬂmmsﬂw.. 2k Cil+P
Jacument Color Made »
Flenlo.. Ak Shifte Ciri=]

Chl+P

Bkt g

Continued on the next page
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62

(2]

General |
Select Prnter

i RolandVW
[ RolandVW_{XR-640)

Cument Page

(P ][ )

Orientation:
Page Order,
Front to Back -

Page Format
Pages per Sheet 1 .

Draw Borders

4 Roland VersaWorks Advanced Document Settings
=-4] Paper/Output

Paper Size: [
=[] Graphic 0
& @) Image Colot 57 a1
ICMMel 3 22
ICMinte =9 a3
Scaling: 100 DM
TrueType F¢ 5] ansiC
& B Document Opti 2] ansi D
Advanced P 5] gnsiE
- Pages per SI () ARCH A
5888 Postcript C 5] aRCH B
Pk Piinter Feats 1) arcH C
Inputhdl | ARCH D
—-— Outputh 2 ARCHE
RGBCut 5 g1
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@ Turn on the [Print to file] option.
@ Click [Preferences].
® Click [Advanced] in the [Layout] tab.

@ Click the down arrow to the right of the
[Paper Size] box, and then click PostScript
Custom Page Size] from the list that ap-
pears.

® For "Custom Page Size Definition," en-
ter the values in the "Width" and "Height"
fields.

Enter values for the same size as the illustration you
created in step 2..



4-5 Performing Texture Printing

@ Click [OK] three times to close the "PostScript Custom Page Size Definition," "Roland
VersaWorks Advanced Options," and "Printing Preferences" dialog boxes.

The "Print" dialog box returns.

@ Click [Print].

o

® Click [Print].

@ Specify the destination and file name

(5]
@* o=@ Example: "TEX_print" for the folder to save to, and "
5 tex.ps " as the file name

This folderis empty.

® Click [Save].

[l
E The CMYK layer of the image is saved as a PS file.
: @

@ 2|

@ Open the folder you saved to and make sure the file has been created.
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4-5 Performing Texture Printing

Performing Texture Printing

Procedure

o Have the printing data created in P. 58, "Create The Texture Printing Data" ready.

9 Set up the "matte-finish printing"” with the VersaWorks, and execute the printing.
= P. 32, "Matte-finish Printing (White or CMYK Colors = Gloss)"
= P. 34, "Matte-finish Printing (Single-pass CMYK and Gloss Printing)"
<= P. 41, "Printing Using Only Gloss Ink"

(IMPORTANT!)

For the finishing state, we recommend "matte-finish printing." It is difficult to produce fine textured
expressions with gloss-finish or embossed-finish.
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